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  AA  NNeeww  PPRROOTTRRAAIINN!!  
 

In case you haven’t heard, things are happening at PROTRAIN!  
Good things that will ensure our customers have the best of 
service and training! 
On February 2, 2001, we became a division of Vivid Learning 
Systems.  Vivid Learning Systems is owned by NUVOTEC and 
delivers HGET training to the Hanford site employees.  They 
also have an extensive library of web-based training options that 
will enhance PROTRAIN’s offerings especially in advanced 
technical training.   
Some of you have already met with Kevin Smith, the President 
of Vivid Learning Systems, and Wayne Heaton, the new Sales 
Manager for PROTRAIN.  They will be managing PROTRAIN 
and instrumental in the growth of the company.   
Their plans include expanding the hours of PROTRAIN into the 
evenings and weekends.  They will be adding new courses to 
our open enrollment schedule and making their web-based 
training available to better meet the needs of our technical 
customers.  They are keeping our two excellent instructors, so 
you will continue to receive the best of care and training!  ! 
If you have any suggestions regarding courses, schedule, etc., 
please feel free to contact Kevin at Kevin@learnatvivid.com or 
Wayne at wayne@learnatvivid.com. 
 This weekend PROTRAIN will be moving to a new location—the 
1163 building on Stevens Drive.  The address is 2345 Stevens 
Drive.  See map in second column.  It is a large building that is 
partially occupied by NUVOTEC—you’ll see their sign on the left 
half of the building.  PROTRAIN will be situated on the second 
floor.  Participants in our training courses will enter at the left end 
of the building and take the elevator or stairs up to the second 
floor.  It is a nicer facility than we are currently in and we think 
you will like the change. 
 My plans are to continue for a few months as a consultant 
assisting with the transition and developing new courses for 
PROTRAIN.  I can still be contacted at sheila@protrainsys.com 
for now. Then on to bigger and better things like being full-time 
Mom for once.  There is a lot about PROTRAIN that I will miss—
most of all the people!  It was a pleasure doing business with so 
many of you, and it was rewarding being a part of the significant 
process of personal growth and increased productivity for 
thousands of you in this community. 
July 1, 2001, PROTRAIN will celebrate its 7th year anniversary.  I 
am so thankful to each one of you who supported PROTRAIN 
and made us the training center we are today.  Thank you! 

PPRROOTTRRAAIINN’’ss  NNeeww  LLooccaattiioonn 

Beginning on Monday, March 5, all of PROTRAIN’s courses will 
be at our new location—2345 Stevens Drive in Richland.  See 
map below.  

 
We will still have the same phone number—call us anytime if 
you have questions regarding these changes.  We’ll be happy to 
help in any way that we can to make this transition as smooth as 
possible. Thank you for your understanding and flexibility as we 
grow.  We look forward to many more years of serving YOU! 

-- Sheila Y. Schroeder, former Owner 
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1 A New PROTRAIN! 
1 PROTRAIN’s New Location 
2 Creating Tables 
2 Word TIP of the Month – Viewing Documents 
3 Viruses and Outlook 2000 
3 Access TIP of the Month – Splash Screens 
3 New Terminology—Clickstreams 

3-4 Hyperlinks to Outlook Folders 
4 Have you been missing out? 
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CCrreeaattiinngg  ttaabblleess  
  
You can quickly create a simple table by using the Insert Table 
command, or you can use the Draw Table tool to quickly create 
a more complex table—for example, one that contains cells of 
different heights or a varying number of columns per row. Using 
Draw Table (the ‘pencil’ icon on the Tables and Borders 
Toolbar) is similar to drawing a rectangle on graph paper — 
first, draw a line from one corner of the table to the corner 
diagonally opposite in order to define the boundary of the entire 
table, and then draw the column and row lines inside. 
Creating tables inside other tables 
You can also use Draw Table to create tables inside other 
tables, or nested tables. Nested tables are particularly useful 
when you use a table to lay out a page and then want to use a 
table to present information — for example, if you use a table to 
lay out the Web page for your company's sales department, you 
might want to insert in the layout a nested table illustrating the 
department's quarterly earnings. 
Creating tables from existing information 
You can convert existing paragraphs of text to a table. You can 
also create a table from an existing data source, such as a 
database or worksheet.   
 

1. Select (highlight) the text you want to convert. 
2. On the Table menu, point to Convert, and then click 

Text to Table. 
3. Under Separate text at, click the option for the 

separator character you want.  
4. Select any other options you want.  

Formatting tables 
You can enhance your table by adding borders and filling cells 
with colors, patterns, or shading. You can also use the Table 
AutoFormat command to quickly give your table a polished 
design. 
Choose one of the following:  
To add a border to a table, click anywhere in the table.  
To add borders to specific cells, select the cells, including the 

end-of-cell mark.  
 

1. On the Format menu, click Borders and Shading, and 
then click the Borders tab.  

2. When you insert a table, it has a black ½-pt solid single-
line border by default. Use the Style, Color, and Width 
options to add a different border.  

3. Make sure the correct option — Table or Cell — is 
selected under Apply to. Select the other options you 
want.  
                                                                  -- continued in next column 
 

4. To specify that only particular sides get borders, click 
Custom under Setting. Under Preview, click the 
diagram's sides, or use the buttons to apply and 
remove borders. 

5. To specify the exact position of the border relative to 
the text, click Paragraph under Apply to, click 
Options, and then select the options you want.  

Changing the position of text in a table 
By default, Microsoft Word aligns text horizontally in table cells, 
callouts, text boxes, or AutoShapes. You can change the text 
orientation so that the text is displayed vertically by following 
these steps: 
 

1. Select table cell that contains the text you want to 
change. 

2. On the Format menu, click Text Direction. 
3. Click the orientation you want.  

----  JJooddii  EEppppaarrdd,,  IInnssttrruuccttoorr  
  

WWoorrdd  TTIIPP  ooff  tthhee  MMoonntthh  
DDiiffffeerreenntt  WWaayyss  ttoo  VViieeww  aa  WWoorrdd  DDooccuummeenntt  

Print Layout View:  Work in print layout view to see how text, 
graphics, and other elements will be positioned on the printed 
page. This view is useful for editing headers and footers, for 
adjusting margins, and for working with columns and drawing 
objects. 
 

Web Layout View:  Work in Web layout view when you are 
creating a Web page or a document that is viewed on the 
screen. In Web layout view, you can see backgrounds, text is 
wrapped to fit the window, and graphics are positioned just as 
they are in a Web browser. 
 

Normal View:  Work in normal view for typing, editing, and 
formatting text. Normal view shows text formatting but simplifies 
the layout of the page so that you can type and edit quickly. In 
normal view, page boundaries, headers and footers, 
backgrounds, and drawing objects, do not appear. 
 

Outline View:  Work in outline view to look at the structure of a 
document and to move, copy, and reorganize text by dragging 
headings. In outline view, you can collapse a document to see 
only the main headings, or you can expand it to see all headings 
and even body text. Outline view also makes it easy to work with 
master documents. A master document makes it easier to 
organize and maintain a long document, such as a multipart 
report or a book with chapters. In outline view, page boundaries, 
headers and footers, graphics, and backgrounds do not appear. 
 

Print Preview:  In print preview, you can display multiple pages 
of a document in a reduced size. In this view, you can see page 
breaks, hidden text, and watermarks, and you can make editing 
or formatting changes before you print the document. 
  --Jodi Eppard, Instructor 
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VViirruusseess  aanndd  OOuuttllooookk  22000000  
Computer viruses are amazingly prolific. More so through the 
use of the Internet rather than by floppy disks as was the case in 
the early computer era. The Internet has made information both 
bad and good exponentially easier and faster to access. 
Microsoft has taken extraordinary steps to help prevent users of 
its Outlook program from opening possible virus content. It has 
done so by preventing users who use Outlook 2000 from 
accessing an attachment that may be of the type that can 
execute on its own. 
If you send an email with an Access database attached (.mdb 
extension), Outlook will not let the recipient access it. A warning 
is displayed when sending and the message banner indicates it 
is blocked when received. 

  

 
If you have tried to send an Access database or another file type 
that Outlook 2000 blocks just change the extension to .txt. The 
recipient will need to save the attached Access database file to 
their file system and rename the file to the correct extension. Be 
sure and include directions in the email to save and change the 
extension back to .mdb once received. I recommend using your 
virus scanner on the saved attachment’s folder before opening 
the file.  
 
Home users should always save any attachments to a folder first 
and check the folder for viruses before opening any incoming e-
mail’s attached file. I would never try to open an attachment that 
has a .vbs extension without checking it out thoroughly. This is a 
Visual Basic Script file and the majority of them seem to be of 
the damaging flavor rather than of the informative. 
 

-- Mike Gallagher, Lead Instructor and Technical Manager 

AACCCCEESSSS  TTiipp  ooff  tthhee  MMoonntthh  
CCrreeaattiinngg  aann  AAcccceessss  SSppllaasshh  SSccrreeeenn  

Access will display a startup splash screen while Access and a 
database file is loading. This can add a more professional 
finished touch to your Access application. Create a Bitmap 
image with a .bmp extension. Save it to the same folder as the 
database file you want it to open up with. Give it the same name 
as the database file only with the .bmp extension rather than the 
.mdb extension. Access will display this image while the same-
named database is loading. 

----  MMiikkee  GGaallllaagghheerr,,  LLeeaadd  IInnssttrruuccttoorr  aanndd  TTeecchhnniiccaall  MMaannaaggeerr  

  

NNeeww  TTeerrmmiinnoollooggyy  

Clickstream -- [klík str  m ] (plural click∙streams) noun  
path through World Wide Web:  the path of mouse clicks that a 
computer user adopts to navigate the World Wide Web.  Some 
Web sites trace and record their visitors' clickstreams as part of 
their marketing research.  

--  MMiikkee  GGaallllaagghheerr,,  LLeeaadd  IInnssttrruuccttoorr  aanndd  TTeecchhnniiccaall  MMaannaaggeerr  

 

HHyyppeerrlliinnkkss  ttoo  OOuuttllooookk  FFoollddeerrss  

In Windows programs and Windows itself you can create 
hyperlinks. Hyperlinks allow users to navigate quickly with one 
mouse click to another location, page, program, file, etc. 
Creating hyperlinks to specific Outlook folders may be necessary 
to look something up while working on a letter in Word or other 
program file. You may need to look up when your appointment is 
with the person to whom you are writing the letter. 
 
I like to place toolbar buttons in the office programs that will 
quickly open the calendar, inbox, contacts, tasks, notes and 
journal folders. The syntax for the hyperlink is “program 
name:folder name”, such as outlook:calendar. You will need to 
add a custom toolbar button that has hyperlink capabilities. In 
Word I use the Microsoft Mail command from the All Commands 
category listing 
 
To create a hyperlink that opens the Outlook Calendar folder 
from Word, 
 

1. Open the Toolbar Customize dialog box by clicking on 
Tools, and Customize. 

2. Click on the Commands tab, and then scroll down the 
Categories list on the left to find and click All 
Commands. 

3. Scroll down the Commands list on the right to find and 
drag MicrosoftMail. 

 
-- continued on next page 
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4. Drag MicrosoftMail to a Toolbar or Menu bar. 
5. Right-Click on the added Microsoft Mail toolbar button, 

point to Assign Hyperlink, and click on Open…. 
 

 
 

6. In the Type the File or Web page name: box enter 
“outlook:calendar”, with out the quotes. 

7. Click OK, and then click Close to close the Customize 
dialog box. 

 

 
 

 
8. Try your new toolbar button; it should take you directly 

to Outlook and the Calendar folder with a single click. 
 

Note: If Outlook is already open this will open a new window 
with the Calendar folder displayed. 

 
In Excel use the Macros Category, Custom Button Command 
within the toolbar Customize dialog box to do the same thing as 
the above Word example. In Access use the File Category, 
Custom Command. 
 
It is possible to go directly to a subject or name of an item in an 
Outlook folder by adding a /~subject or name to open, such as 
“outlook:calendar/~budget mtg” or “outlook:contacts/~Mike 
Gallagher”. This could be useful from Access or Excel where you 
may keep a list of the contacts collaborating on a particular 
project and want quick access to their Contact folder entries 
from within the project file. 
 

----  MMiikkee  GGaallllaagghheerr,,  LLeeaadd  IInnssttrruuccttoorr  aanndd  TTeecchhnniiccaall  MMaannaaggeerr  

  

-- next column 

 
 
 
 
 
Check out these GREAT courses . . . 

"# FrontPage Intermediate training now 
available! 
 

FrontPage 00 Beginning  March 8 
FrontPage 00 Intermediate March 9 

"# Publisher 2000 training available! 
 

Publisher 2000    March 6 

"# QuickBooks Pro 2000 training is here! 
 

QuickBooks Pro 00 Beginning March 12 
QuickBooks Pro 00 Interm. March 13 

"# Crystal Reports training! 
 

Crystal Reports Intro.  March 22 
Crystal Reports Advanced March 23 

"# Visio 2000 Flow/Organization Charting! 
 

Visio 2000 Charting  March 5 

Call 946-1123 to register today! 
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